Thank you very much for purchasing this product.

➢ To ensure correct and safe usage with a full understanding of this product’s performance, please be sure to read through this manual completely and store it in a safe location.
➢ Unauthorized copying or transferral, in whole or in part, of this manual is prohibited.
➢ The contents of this operation manual and the specifications of this product are subject to change without notice.
➢ The operation manual and the product have been prepared and tested as much as possible. If you find any misprint or error, please inform us.
➢ Roland DG Corp. assumes no responsibility for any direct or indirect loss or damage which may occur through use of this product, regardless of any failure to perform on the part of this product.
➢ Roland DG Corp. assumes no responsibility for any direct or indirect loss or damage which may occur with respect to any article made using this product.

Roland DG Corporation
Roland DG Corporation (hereinafter referred to as the “Company”) shall grant you a non-transferable, non-exclusive right to use the Software supplied with this Agreement, on the condition that you agree to the following provisions. Install the software if you agree with the following provisions. The Agreement is deemed to have been concluded once the software has been installed. If you do not agree with the following provisions, do not install the software.

1. Definition
The “Software” includes the software program and related files supplied with this Agreement and the related software programs and files distributed through the Internet and other services.

2. Ownership
All the ownership, copyright and other intellectual property rights of the Software, trademark, and related documents shall belong to the Company.

3. Terms and conditions
   (1) You are authorized to use the Software on one computer.
   (2) You are allowed to create a backup copy of the Software.
       The right to keep the Software and the backup copy of the Software continues to belong to the Company, but the right to the media on which the backup copy of the Software is recorded does not belong to the Company.

4. Forbidden items
   (1) This copy of the Software, or a backup copy of the Software, must not be used on multiple computers at the same time, on a network, the Internet, or on other computers through any other means of distribution.
   (2) The Software shall not be reverse engineered, decompiled or reverse assembled.
   (3) The rights to the Software cannot be transferred, assigned, lent, loaned or licensed to a third party in any case, regardless of whether this Agreement has been terminated or cancelled.

5. Termination
   (1) The Company can cancel this Agreement and require you to discontinue use of the Software if you breach any provision of this Agreement or if you infringe on the ownership, copyright, or other intellectual property rights of the Company.
   (2) This Agreement shall be automatically terminated when you stop using the Software.
   (3) If this Agreement is terminated or cancelled, you must return your copy of the Software to the Company, or discard it as soon as practicable, at your own expense.

6. Guarantee
   (1) The Company shall not guarantee that the quality or functionality of the Software will satisfy any purpose that you may have in mind.
   (2) The Company shall not accept any responsibility for the results obtained from using the Software.
   (3) The Company shall not accept any responsibility for any loss which might be caused as a result of your exercising the rights granted under this Agreement.
   (4) The specifications for the Software are subject to change without prior notice.

7. Governing law
This Agreement shall be governed by the laws of Japan.
Contents

To Ensure Safe Use ......................................................................................................................... 2
Pour utiliser en toute sécurité ................................................................................................. 4
Important Notes on Handling and Use ................................................................................. 6

Chapter 1 Preparing the Sensor Unit ..................................................................................... 7
1-1 3D Scanning Sensor Unit ................................................................................................. 8
   Supported Models .................................................................................................................. 8
   Unit Features ........................................................................................................................ 8
   Checking the Included Items ............................................................................................. 8
   Part Names and Functions ................................................................................................. 9
1-2 Installing the Sensor Unit ............................................................................................... 10
   Installing the Sensor Unit .................................................................................................. 10
   To Reinstall the Spindle Unit ........................................................................................... 11
1-3 Preparing the Programs .................................................................................................. 12
   System Requirements for the Programs ......................................................................... 12
   System Requirements for USB Connection .................................................................... 12
   Step 1: Installing and Setting Up the Programs .............................................................. 12
   Step 2: Making the Settings for Dr. PICZA3 .................................................................. 14

Chapter 2 Use and Operation As a 3D Scanner ............................................................... 15
2-1 Operation As a 3D Scanner ............................................................................................. 16
   Objects That Can and Cannot Be Scanned ...................................................................... 17
   Mounting the Object to Scan .......................................................................................... 18
2-2 Using the Included Programs ........................................................................................ 19
   User’s Manuals for the Programs .................................................................................. 19
   Amount of Computer Memory Required ........................................................................ 20

Chapter 3 Basic Scanning Operation ................................................................................. 21
3-1 Learning the Basics of Scanning .................................................................................... 22
   Step 1: Setting the Scanning Conditions ......................................................................... 22
   Step 2: Checking the Scanning Results .......................................................................... 24
   Step 3: Saving and Exporting Data ................................................................................. 24

Chapter 4 Appendix ............................................................................................................ 25
4-1 What to Do If... ............................................................................................................... 26
   The machine doesn’t start ............................................................................................... 26
   Scanning is impossible .................................................................................................... 26
   Other Symptoms ............................................................................................................. 26
4-2 Specifications .................................................................................................................. 27
   Scanning-mode Specifications ....................................................................................... 27

Windows® and Windows NT® are registered trademarks or trademarks of Microsoft® Corporation in the United States and/or other countries.
Pentium is a registered trademark of Intel Corporation in the United States.
Other company names and product names are trademarks or registered trademarks of their respective holders.

Copyright © 2005-2009 Roland DG Corporation

http://www.rolanddg.com/
To Ensure Safe Use

Improper handling or operation of this machine may result in injury or damage to property. Points which must be observed to prevent such injury or damage are described as follows.

*Please also read the important safety information in the user’s manual for the modeling machine.

About ⚠️ WARNING and ⚠️ CAUTION Notices

<table>
<thead>
<tr>
<th>❗️ WARNING</th>
<th>Used for instructions intended to alert the user to the risk of death or severe injury should the unit be used improperly.</th>
</tr>
</thead>
</table>
| ⚠️ CAUTION                      | Used for instructions intended to alert the user to the risk of injury or material damage should the unit be used improperly.  
* Material damage refers to damage or other adverse effects caused with respect to the home and all its furnishings, as well to domestic animals or pets. |

About the Symbols

<table>
<thead>
<tr>
<th>![Symbol]</th>
<th>The ⚠️ symbol alerts the user to important instructions or warnings. The specific meaning of the symbol is determined by the design contained within the triangle. The symbol at left means “danger of electrocution.”</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Symbol]</td>
<td>The ✖️ symbol alerts the user to items that must never be carried out (are forbidden). The specific thing that must not be done is indicated by the design contained within the circle. The symbol at left means the unit must never be disassembled.</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>The ⚪️ symbol alerts the user to things that must be carried out. The specific thing that must be done is indicated by the design contained within the circle. The symbol at left means the power-cord plug must be unplugged from the outlet.</td>
</tr>
</tbody>
</table>
To Ensure Safe Use

⚠️ Incorrect operation may cause injury

**WARNING**

Be sure to follow the operation procedures described in this manual. Failure to follow the procedures may cause sudden operation or the like of the machine, which may result in unexpected injury.

Never touch the tip of the probe. Also, be sure to attach the probe cover when the sensor unit is not in use. The tip of the probe is very sharp, and can cause injury or blindness.

Do not disassemble, repair, or modify. Doing so may lead to fire or abnormal operation resulting in injury.

Never allow anyone unfamiliar with the usage or handling of the machine to touch the machine. Touching a dangerous location may cause sudden operation or the like of the machine, which may lead to an unexpected accident.

Never allow children near the machine. The machine includes locations and components that pose a danger to children, and major accident, including injury, blindness, or choking, may occur.

Never touch the tip of the probe. Also, be sure to attach the probe cover when the sensor unit is not in use. The tip of the probe is very sharp, and can cause injury or blindness.

Do not disassemble, repair, or modify. Doing so may lead to fire or abnormal operation resulting in injury.

**Important Notes on Scanning**

**CAUTION**

Never attempt to scan any object of high intrinsic or personal value, or that would otherwise be difficult to replace if damaged or broken. Because scanning involves contact by the probe, the object scanned may be damaged. Incorrect settings may also cause the scanned object to strike areas other than the probe. Scan-object damage is not covered by warranty.

When loading an object to scan, make sure that all sides and the top of the object are within the scannable area. A scanned object may strike a component other than the probe and suffer damage. Scan-object damage is not covered by warranty.

Be sure to remove the probe cover when performing scanning. Otherwise the object scanned may strike the probe cover and suffer damage. Scan-object damage is not covered by warranty.
Pour utiliser en toute sécurité

La manipulation ou l'utilisation inadéquates de cet appareil peuvent causer des blessures ou des dommages matériels. Les précautions à prendre pour prévenir les blessures ou les dommages sont décrites ci-dessous.

*Lire sans faute les importants renseignements sur la sécurité dans le guide de l'utilisateur de la machine à modeler.

Avis sur les avertissements

| ATTENTION | Utilisé pour avertir l'utilisateur d'un risque de décès ou de blessure grave en cas de mauvaise utilisation de l'appareil. |
| PRUDENCE       | Utilisé pour avertir l'utilisateur d'un risque de blessure ou de dommage matériel en cas de mauvaise utilisation de l'appareil. *

Par dommage matériel, il est entendu dommage ou tout autre effet indésirable sur la maison, tous les meubles et même les animaux domestiques.

À propos des symboles

<table>
<thead>
<tr>
<th>Symbole</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Alerte" /></td>
<td>Le symbole <strong>Alerte</strong> attire l'attention de l'utilisateur sur les instructions importantes ou les avertissements. Le sens précis du symbole est déterminé par le dessin à l'intérieur du triangle. Le symbole à gauche signifie &quot;danger d'électrocution&quot;.</td>
</tr>
<tr>
<td><img src="image2" alt="Interdit" /></td>
<td>Le symbole <strong>Interdit</strong> avertit l'utilisateur de ce qu'il ne doit pas faire, ce qui est interdit. La chose spécifique à ne pas faire est indiquée par le dessin à l'intérieur du cercle. Le symbole à gauche signifie que l'appareil ne doit jamais être démonté.</td>
</tr>
<tr>
<td><img src="image3" alt="Prévenir" /></td>
<td>Le symbole <strong>Prévenir</strong> prévient l'utilisateur sur ce qu'il doit faire. La chose spécifique à faire est indiquée par le dessin à l'intérieur du cercle. Le symbole à gauche signifie que le fil électrique doit être débranché de la prise.</td>
</tr>
</tbody>
</table>
L'utilisation incorrecte peut causer des blessures

**ATTENTION**

*S'assurer de suivre les procédures d'utilisation décrites dans ce manuel.*

Si les procédures indiquées ne sont pas suivies, le fonctionnement de l'appareil peut être déclenché soudainement, ce qui risque de causer des blessures.

*Ne jamais permettre à quiconque de toucher l'appareil s'il ou si elle n'en connaîse pas le fonctionnement ou la manutention.*

Toucher l'appareil à certains points dangereux peut en déclencher le fonctionnement, ce qui risque de causer un accident imprévu.

*Ne jamais laisser d'enfants s'approcher de l'appareil.*

Des éléments et des surfaces de l'appareil présentent des risques pour les enfants. Il pourrait se produire un accident grave qui causerait des blessures, ou créerait un risque de cécité ou de suffocation.

**Remarque importante sur la numérisation (scanning)**

**PRUDENCE**

*Ne jamais tenter de numériser un objet de grande valeur monétaire ou sentimentale, ou un objet qui serait difficile à remplacer s'il était endommagé ou brisé.*

Les objets numérisés risquent d’être endommagés parce que la numérisation exige un contact entre la sonde et l’objet. En outre, si les réglages sont erronés, l’objet numérisé peut frapper des points autres que la sonde. La garantie ne couvre pas les objets numérisés.

*Pendant le chargement d'un objet à numériser, s'assurer que tous les côtés et la partie supérieure de l'objet sont à l'intérieur de la surface numérisable.*

Un objet numérisé peut frapper une composante autre que la sonde et être endommagé. La garantie ne couvre pas les objets numérisés.

*S'assurer de retirer le couvert de la sonde pour faire la numérisation.*

Sinon, l’objet numérisé peut frapper une composante autre que la sonde et être endommagé. La garantie ne couvre pas les objets numérisés.
This unit is a precision device. To ensure the full performance of this unit, be sure to observe the following important points. Failure to observe these may not only result in loss of performance, but may also cause malfunction or breakdown.

**This Unit Is a Precision Device**

➢ Never drop or subject to impact.
➢ Never twist or wrench the probe by hand.
➢ When not using the sensor unit, attach the probe cover and store in a safe place.

**Items That may Not Be Copied**

Unauthorized reproduction of a copyrighted item for any purpose other than personal use may be a violation of copyright. Roland DG Corp. will not be responsible for any violation of third-party copyright by any article made through use of this product.
Chapter 1
Preparing the Sensor Unit
1-1 3D Scanning Sensor Unit

Supported Models

➢ Roland DG MDX-40series  
➢ Techsoft TS-30

Most of the figures in this document depict the MDX-40.

Unit Features

This is an optional unit that enables you to use any of the preceding compatible models of modeling machines as a 3D scanner. Replacing the spindle unit with the sensor unit adds contacting 3D-scanner functionality. Dedicated programs for 3D scanning and for editing 3D data are included.

Checking the Included Items

Sensor unit  
Cap screws (black)  
Hexagonal wrench (3 mm)*

Clay  
Roland Software Package CD-ROM  
User's Manual (this manual)

* A 2.5-mm hexagonal wrench is included with the modeling machine.
Part Names and Functions

**Probe cover**
This cover protects the probe. When not using the sensor unit, be sure to attach the probe cover.

**Probe**
This touches the scan object and senses its shape.

**Connector**
This is the connector for connection to the modeling machine.
Installing the Sensor Unit

⚠️ CAUTION ⚠️ Before you carry out this operation, switch off the power to the modeling machine. Failing to do so may result in sudden movement of the machine, causing the hands or fingers to become caught and resulting in injury.

⚠️ CAUTION ⚠️ Do not touch the spindle motor immediately or cutter after a cutting operation has ended. Doing so may result in burns.

⚠️ CAUTION ⚠️ Perform installation and removal of the sensor unit while the cover is attached. Otherwise the probe may stab the hand or fingers and cause injury.

Before you install the sensor unit, complete the setup operations for the modeling machine. For information on how to perform setup, refer to the documentation included with the modeling machine.

Procedure

1. Switch off the power to the modeling machine and unplug its power cord. If a tool is installed, then remove it.
2. Remove the belt.

2. Remove the cap screw shown in the figure.
3. Remove the spindle unit.

3. Install the sensor unit, using black cap screws.
Installing the Sensor Unit

4 Slightly loosen the cap screw shown in the figure.
   2 Turn the connector cover to open it.
   3 Retighten the cap screw.

Insert the cable for the sensor unit into the connector.

5 Detach the probe cover.

⚠️ CAUTION
Be sure to remove the probe cover when performing scanning.
Otherwise the object scanned may strike the probe cover and suffer damage. Scan-object damage is not covered by warranty.

Carefully store the removed spindle unit, belt, cap screw, and probe cover so that they do not become misplaced.

To Reinstall the Spindle Unit

➢ Switch off the power to the modeling machine, then carry out installation by following the foregoing procedure in reverse.
➢ The belt has an inner side and an outer side. Be sure the two sides are oriented correctly.
➢ After attaching the belt, turn the pulley by hand several times to acclimatize the belt.

The white mark indicates the outer side.
1-3 Preparing the Programs

System Requirements for the Programs

<table>
<thead>
<tr>
<th>Operating system:</th>
<th>Windows XP/Vista</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU:</td>
<td>Pentium 4 processor or better recommended</td>
</tr>
<tr>
<td>Memory:</td>
<td>512 MB or more recommended</td>
</tr>
<tr>
<td>Free hard-disk space required for installation:</td>
<td>Dr. PICZA3: 20 MB or more, 3D Editor: 10 MB or more</td>
</tr>
<tr>
<td>Display:</td>
<td>800 x 600 resolution and 16 bit colors (High Color) or more recommended, OpenGL-compatible accelerator board recommended.</td>
</tr>
</tbody>
</table>

➢ The Windows-based driver for the modeling machine must already be installed and the computer and modeling machine must be connected by a USB cable.
➢ Memory requirement are affected by scanning conditions and the like. Larger scanning areas and finer scanning pitches require increasingly more memory. We recommend installing enough memory to match your usage conditions.

Step 1: Installing and Setting Up the Programs

Programs to Install and Set Up
➢ Dr. PICZA3: This program enables you to perform 3D scanning.
➢ 3D Editor: This program enables you to edit scanned 3D data.

Procedure

1. Install the Windows-based driver for the modeling machine and make the connection using a USB cable.
   For more information, refer to the documentation included with the modeling machine. If the connection is already made, go on to procedure 2 below.

2. Log on to Windows as “Administrators.”
   Insert the Roland Software Package CD-ROM into the computer.
   (Windows Vista only: When the automatic playback window appears, click [Run menu.exe].) The setup menu appears automatically.
Click the program you want to install and setup.

Windows XP
The setup program starts. Follow the messages to carry out setup and finish setting up the program.

Windows Vista
The [User Account Control] appears, click [Allow]. The setup program starts. Follow the messages to carry out setup and finish setting up the program.

When installation finishes, the screen shown at left appears. Click [Close] or [OK].

Repeat steps 3, 4, and 5 to install and set up each program.
1-3 Preparing the Programs

Step 2: Making the Settings for Dr. PICZA3

Procedure

1. **ON**
   - Turn on the power to the modeling machine.

2. From the [Start] menu, click [All Programs] - [Roland Dr. PICZA3] - [Dr. PICZA3].
   - Go to the [File] menu and click [Preferences].

3. For [Port], select the model name of the modeling machine you’re using.
   - Click [OK].
   - Go to the [File] menu and click [Exit] to quit Dr. PICZA3.

This completes the preparations for the program.

Checking the Connection

In Dr. PICZA3, go to the [Help] menu and display [About]. If the firmware version and model name are displayed, the connection is correct.
Chapter 2
Use and Operation As a 3D Scanner
2-1 Operation As a 3D Scanner

Operation As a 3D Scanner

Startup

1. Close the front cover.

2. Switch on the main power switch. The POWER light comes on.

3. Press the Sub power button. The machine starts up, and initialization is performed.

To Start Scanning
- Confirm that the SCANNING light comes on.
- Confirm that the VIEW lamp goes dark.
- During scanning, never open the front cover.
- You can pause scanning by pressing the VIEW button. Pressing the VIEW button a second time resumes operation.
- You can open the front cover while operation is paused.

Operation During the Scanning Mode
- The SCANNING light comes on when the machine is in the scanning mode.
- The machine automatically changes to the scanning mode when the sensor unit is installed and to the modeling mode when the spindle unit is installed.
- The operation of other buttons and controls is identical both in the scanning mode and in the modeling mode. Refer to the documentation included with the modeling machine.
- When in the scanning mode, the "operation-panel screen(VPanel)" cannot be used.
Objects That Can and Cannot Be Scanned

Objects Unsuitable for Scanning
Objects that change shape when touched by the probe cannot be scanned.

➢ For example, objects such as items made of soft rubber or fuzzy stuffed animals cannot be scanned.
➢ Depending on the configuration of the object, error equal to about the radius of the probe (0.5 mm) may occur.

⚠️ CAUTION Never attempt to scan any object of high intrinsic or personal value, or that would otherwise be difficult to replace if damaged or broken. Because scanning involves contact by the probe, the object scanned may be damaged. Incorrect settings may also cause the scanned object to strike areas other than the probe. Scan-object damage is not covered by warranty.

Scannable Area
The figure shows the scannable area.

The size that can actually be scanned depends on the amount of memory in the computer. For more information, refer to page 20, "Amount of Computer Memory Required."
Mounting the Object to Scan

Mounting the Object to Scan
➢ Secure in place with the surface to scan facing up.
➢ Secure firmly to keep from moving during scanning.

⚠️ CAUTION When loading an object to scan, make sure that all sides and the top of the object are within the scannable area. A scanned object may strike a component other than the probe and suffer damage. Scan-object damage is not covered by warranty.

Various Methods for Securing in Place
➢ Double-sided adhesive tape can be useful for flat-bottomed object.

➢ When the bottom is uneven, it may be possible to secure the object by pressing it into a piece of clay.

To Scan a Small or Thin Object
If the portion you want to scan isn’t positioned inside the scanning area, place a block or the like underneath it to elevate it. However, be sure to keep its height at 92.4 mm (3-5/8 in.) or less from the table surface.
2-2 Using the Included Programs

User's Manuals for the Programs

Description of Basic Operation
See page 21, "Chapter 3 Basic Scanning Operation"

Detailed Description
You can find detailed explanations of the programs in the online help (electronic-format manuals).

Dr.PICZA3
From the [Start] menu, click [All Programs] - [Roland Dr. PICZA3] - [Dr. PICZA3 Help].

3D Editor
From the [Start] menu, click [All Programs] - [Roland 3D Editor] - [3D Editor Help].

The Machine's Scanning Mode
This machine has only a single scanning mode. It does not support such scanning methods as rotary, plane, line, or point scanning.
Data exported using the "Polylines" command is not supported.
Amount of Computer Memory Required

Important Note about Required Memory
The amount of memory required increases proportionally as the dimensions of the scanning area grow larger or as the scanning pitch is made finer. Insufficient memory can slow down the operation of the computer, and even make it appear to freeze.

Estimating the Memory Requirements
Use the following information as a guide to estimate the amount of memory that Dr. PICZA3 requires. (These figures do not include memory required by the operating system itself.)

<table>
<thead>
<tr>
<th>Scanning area (width x depth)</th>
<th>Scanning pitch</th>
<th>Required memory</th>
</tr>
</thead>
<tbody>
<tr>
<td>100 x 100 mm</td>
<td>0.05 x 0.05 mm</td>
<td>Approx. 2 GB</td>
</tr>
<tr>
<td>100 x 100 mm</td>
<td>0.1 x 0.1 mm</td>
<td>Approx. 500 MB</td>
</tr>
<tr>
<td>100 x 100 mm</td>
<td>0.5 x 0.5 mm</td>
<td>Approx. 20 MB</td>
</tr>
</tbody>
</table>
Chapter 3
Basic Scanning Operation
Step 1: Setting the Scanning Conditions

Let’s start actually scanning something. You mount the object to be scanned, start the 3D scanner, then use the 3D-scanning program to begin scanning.

Procedure

1. Start Dr. PICZA3 and display the [Settings for Scanning] dialog box.

   - From the [Start] menu, click [All Programs] - [Roland Dr. PICZA3] - [Dr. PICZA3].
   - Click [Scan].

2. Make the settings for the area to scan (width and depth).

   - Type in the lower-left and upper-right locations of the scanning area.

   ➢ Clicking this returns to the original view.
   ➢ This enlarges (zooms) the displayed view. Click this, then drag to enclose the area you want to enlarge.
   ➢ Click this to set or verify the scanning area.
   ➢ The orange quadrilateral indicates the area to scan (width and depth).
   ➢ Double-clicking a red square moves the probe to that location. You use this to verify the scanning area.
   ➢ You can make the settings for the scanning area by dragging the red squares.

It’s a good idea to reduce the area to the smallest size necessary. Making the area larger than necessary increases the scanning time and uses up excess memory.
3 Make the settings for the area to scan (height direction).

- Enter the lower limit of the scanning area (the distance of the location from the table surface).
- Click this check box to select it.
- Find the highest location on the scan object. Then drag this marker to that location.
- Click this button.

➢ The probe moves and touches the highest location of the scan object. (The area above this is not scanned.)
➢ If the location touched is not the highest, then redo ③ and √. If it is difficult to guide the probe to the location you want, it may be useful to place a thick piece of paper or the like on top of the scan object, then make the probe touch the surface of the paper.
➢ Omitting this setting causes the entire scannable area to be scanned from top to bottom.

It’s a good idea to reduce the area to the smallest size necessary. Making the area larger than necessary increases the scanning time and uses up excess memory.

4 Set the scanning pitch, then start scanning.

- Enter the scanning pitch.
- Click [Scan].

Be careful not to make the scanning pitch too small. Smaller settings for the scanning pitch permit scanning with correspondingly greater detail, but also use up correspondingly larger amounts of memory.
3-1 Learning the Basics of Scanning

Step 2: Checking the Scanning Results

You can preview the results while dragging the object to change its orientation and positioning.

These change how the object moves when dragged (rotation, sliding, or zoom).

These change the view.

The three-dimensional item that has been scanned is called the "object."

Step 3: Saving and Exporting Data

If the results are acceptable, then save the data. You can also save (export) data converted to a format that other programs can import.

**Save**

Go to the [File] menu and click [Save As].

Data saved using this method can be opened in Dr. PICZA3 and 3D Editor.

Once you have saved this data, you can export it in a variety of different formats.

**Export**

Go to the [File] menu and click [Export].

3D Editor also has an export feature. It lets you export data in a wider variety of formats than Dr. PICZA3.
Chapter 4
Appendix
4-1 What to Do If...

**The machine doesn't start**

**The VIEW light is flashing.**
The sub power button was pressed while the front cover was open, or the front cover was opened just after the sub power button was pressed.

[M DX-40A]
Close the front cover.

[M DX-40, TS-30]
Close the front cover and switch the power off. Keep the front cover closed until startup finishes.

**The SCANNING light flashes every 0.5 second.**
The front cover was opened before startup finished. Close the front cover and switch the power off. Keep the front cover closed until startup finishes.

**The SCANNING light flashes every 0.1 second.**
Something touched the sensor during initial operation immediately after switching on the power, or a hardware error occurred.
If there is an obstruction, then switch off the power, remove the obstruction, and switch the power back on. If there was a hardware error, then switch the power off and back on and repeat the same operation. If the same error display occurs, consult your authorized Roland dealer or service center.

**Scanning is impossible**

**The MODELING light is on.**
The sensor unit is not connected. Switch off the power and check again to make sure the sensor unit is installed.

**The computer displays the message "Cannot communicate with present scanner."**
Was the modeling machine restarted while Dr . PICZA3 remained running?
Restart Dr . PICZA3. Restarting the modeling machine while Dr . PICZA3 remains running makes communication impossible.
The setting for the communication port in [Preferences] for Dr. PICZA3 is incorrect. Refer to page 14, "Step 2: Making the Settings for Dr. PICZA3," and check the setting.
Alternatively, no Windows-based driver for the modeling machine is installed. Refer to the documentation for the modeling machine and install the driver. Installing and setting up only Dr. PICZA3 does not enable operation.
Alternatively, try switching off the power and restart-

**The VIEW light is on.**
Operation is paused. Press the VIEW button to release the paused state.

**The VIEW light is flashing.**
The front cover is open. Close the front cover and redo the operation.

**The SCANNING and VIEW lights are flashing.**

[M DX-40A]
Operation cannot be continued.

[M DX-40, TS-30]
The front cover was opened while scanning was in progress. Operation cannot be continued. Switch the power off, and redo the operation. To open the front cover while scanning is in progress, first press the VIEW button to pause operation.

**Other Symptoms**

**Scanning ended, but the computer then stopped.**
Go to Dr. PICZA3’s [Settings for Scanning] dialog box and increase the scanning pitch. Alternatively, consider installing more memory. When scanning exceeds the amount of free memory on the computer, the operation of the computer may become very slow.
# Scanning-mode Specifications

These are the main specifications of the MDX-40 series or TS-30 when the ZSC-1 is installed.

<table>
<thead>
<tr>
<th></th>
<th>MDX-40 series/TS-30 (ZSC-1 installed)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Maximum scanning area</strong></td>
<td>305 (X) x 305 (Y) x 60 (Z) mm (12 (X) x 12 (Y) x 2-5/16 (Z) in.)</td>
</tr>
<tr>
<td><strong>Distance from probe tip to table</strong></td>
<td>Maximum 92.4 mm (3-5/8 in)</td>
</tr>
<tr>
<td><strong>Table load capacity</strong></td>
<td>Maximum 4 kg (8.8 lb)</td>
</tr>
</tbody>
</table>
| **Sensor**         | Type: Roland Active Piezo Sensor (RAPS)  
|                    | Effective probe length: 60 mm (2-5/16 in.)  
|                    | Tip bulb radius: 0.08 mm (0.00315 in.) |
| **Scanning method** | Contacting, mesh-point height-sensing |